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ABSTRACT 

 

A Style Guide Written to Assist in the Planning and Composition of a Dissertation 
in the Graduate School of Education and Professional Development at 

 Marshall University 
Ann Edd Candidate 

 
 The purpose of this style guide is to provide doctoral candidates in the Marshall 
University Graduate School of Education and Professional Development a guide to much 
of the salient information that relates to writing dissertations.  The guide incorporates and 
clarifies the standards of the 6th edition of the Publication Manual of the American 
Psychological Association (APA) and the requirements for the electronic submission of 
dissertations.    
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DEDICATION 

 

 This style guide is dedicated to the doctoral students of Marshall University.  Their 

commitment to excellence and to life-long learning will enhance education for the 

students of our public and private schools and our institutions of higher learning. 
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A STYLE GUIDE WRITTEN TO ASSIST IN THE PLANNING AND 
COMPOSITION OF A DISSERTATION IN THE GRADUATE SCHOOL OF 

EDUCATION AND PROFESSIONAL DEVELOPMENT AT MARSHALL 
UNIVERSITY 

 

CHAPTER ONE: INTRODUCTION TO THE DISSERTATION 

 
 

 This manual is intended to serve as a guide for the preparation, submission, and 

acceptance of doctoral dissertations in the Graduate School of Education and Professional 

Development (GSEPD) at Marshall University.  The purpose of the manual is to ensure 

consistency in format and appearance for all dissertations completed in the school.  While 

it is expected that dissertations will be in accordance with instructions in this manual, 

academic departments and advisory committees may permit exceptions to this format. 

 The manual is presented as a model of a dissertation with front and back matter 

and the body, including headings, citations, and references, used as examples of the 

proper form in a dissertation.  The first chapter is a discussion of the preparation and the 

process of writing a dissertation.  The second chapter presents the proper procedures for 

organizing the manuscript, and the third chapter explains the proper format for the 

document.  There is both a table of contents and index to assist students in using the 

guide and examples of pages that are not appropriate for this document (index of tables 

and curriculum vitae) are presented in Appendix A. 

The Dissertation 

Candidates for the doctoral degree are required to complete advanced, 

independent, scholarly research and present and defend a document that contributes to the 

field of knowledge about an important topic.  While the type of research conducted will 

differ according to the area of study and the interests of the student, all dissertations will 
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“deal with a topic related to the major field of study; embody the results of individual 

research; possess a unity of theme;…show mastery of the literature on the subject; 

demonstrate mastery of appropriate research tools and technique;…provide evidence of 

originality and critical judgment; illustrate the development of broad capabilities, as well 

as an intensive focus on the subject of research;…[be] written in a creditable literary 

style; constitute a significant contribution to knowledge; and [be] worthy of publication”  

(Minkel, 1982, p. 6). 

Style Manuals 

 This style guide should be used to clarify and standardize format issues.  In 

addition to this guide, students are expected to use the approved style manual which is the 

sixth edition of the Publication Manual of the American Psychological Association 

(APA), and the Marshall University format requirements for electronic dissertations 

(ETD).  The format requirements for submission of electronic dissertations can be found 

at http://www.marshall.edu/graduate/etd/importantstepspreparation.asp.  When there is 

inconsistency between the guides, this style guide shall provide the rule.  

  
Committee Approval 

 
 Students are responsible for consistent and correct format in the dissertation.  Any 

exceptions to the criteria in this manual, the APA manual, or the ETD requirements must 

be approved by the student’s dissertation committee.  This approval is contingent upon 

the purpose and type of dissertation.  For example, a student who is writing a historical 

study may be permitted to alter the required number of chapters in order to accommodate 

the purpose of the dissertation. 
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Student Responsibility 
 

 The candidate is ultimately responsible for the dissertation.  The author must 

present a document that is well-written, grammatically correct, properly organized, and in 

a format consistent with the requirements of this style guide and the APA manual.  It 

would be to the student’s benefit to have the document proof-read prior to submission. 

The faculty of the university reserve the right to refuse any manuscript that does not 

observe these guidelines. 

Planning and Preparation 

The Review Process  
  
 While a dissertation is the product of individual research, the research process is 

by nature a collaborative one, with constant review to assure a high quality product.  The 

review process begins with the topic selection and continues after the student has 

successfully defended the dissertation and is submitting manuscripts based on the work to 

peer-reviewed journals.  Before beginning the process, it is important to understand that 

doctoral research and writing will be reviewed often and that the student will continually 

be revising and rewriting.  The work will be reviewed by other students, by faculty other 

than the committee, by the Institutional Review Board, perhaps by a panel of experts 

interested in the topic, and certainly, by the dissertation committee.  To be successful, it 

is important to realize that this process of review and revision is designed to assist the 

candidate and to assure that the dissertation is one that contributes to the education 

knowledge base and that is a credit to the university and to the student as a member of the 

academic community. 
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Approval Process 

 In addition to the constant collaborative review of one’s work, there are several 

formal points for approval.  Each of these steps is explained in detail in the Doctoral 

Program in Education Student Faculty Handbook at http://www.marshall.edu/gsepd/edd.  

Topic selection.  The topic for the dissertation should be one in which the student 

has a professional interest for he or she will be working with the topic for many months.  

It also must be one that will contribute to the knowledge base for the discipline.  

Generally, the student selects the topic after reviewing the literature and exploring recent 

studies related to the topic.  Conversations with the chair are essential at this point.  Once 

the student and the chair have agreed that a topic is worthy of study, a proposal for the 

study will be developed and presented to the full committee in order to gain approval to 

proceed with the work to develop a prospectus. 

 Prospectus.  The prospectus is essentially the first three chapters of the 

dissertation.  Following the chair’s review and approval, the prospectus will be submitted 

to the committee for review.  A formal meeting with the committee will be scheduled and 

at that time, the student will present the prospectus—including the research questions, the 

literature to support interest in these questions, and the methods to be used to study the 

questions.  During this meeting the committee will determine if the candidate has 

presented a reasonable plan for a research study. If the prospectus presents a reasonable 

study, the committee will provide advice and may recommend revisions.  If these 

revisions are substantial, it may be necessary to adjourn or to reschedule the prospectus 

meeting until the revisions are made.  If the revisions are less substantial, the committee 
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may approve the prospectus contingent on revisions being made, and the student may 

proceed with the work.   

 Institutional Review Board (IRB).  The next step in the approval process is 

review by the Marshall University IRB. This board reviews research proposals to assure 

that the research poses no danger to individuals and presents no liability to the university. 

Marshall faculty, staff, and students MUST present any research involving the use of 

human subjects to the IRB for review and approval prior to initiation of the project.  A 

doctoral student may NOT request IRB approval until the prospectus has been approved 

by the student’s committee.  There are four steps in the IRB process: 

1.  Before applying for IRB approval, the student and the chair must successfully 

complete the IRB education/training program.  Information and registration is 

available at http://www.marshall.edu/research/ori/education.asp 

2.  After the prospectus and before beginning any data collection, the student 

must apply for IRB approval.  The details of this procedure and guidelines may be 

found at http://www.marshall.edu/research/ori/.  A template for a sample survey 

consent letter may be found at 

http://www.marshall.edu/research/ori/Template/Anonymous%20Survey%20Cons

ent.pdf and an informed consent template for other types of social science 

research may be found at 

http://www.marshall.edu/research/ori/Template/ICTemplateIRB2.pdf. Copies of 

these templates also may be found in Appendix B.  These letters must be 

produced on Marshall University letterhead available from the Office of Doctoral 

Programs in Education. 
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3. Submit a copy of the IRB Approval to the Office of Doctoral Programs in 

Education. 

4. Upon completion of the research, return to the IRB site to close the study. 

 The defense.  After completing the research, writing, and revision of the 

document, the student will formally present it to the committee.  With the consent of the 

chair and committee, the defense date will be established.  There are several steps in this 

process: 

1. Chair approves tentative date. 

2. Clean copies of the document are provided to all committee members at least 

three weeks prior to the tentative date. 

3. An application to establish a defense date is submitted to the Office of 

Doctoral Programs in Education at least three weeks prior to the tentative 

date.  All committee members must sign this application. 

The defense is a formal oral presentation of the work to the committee, other 

interested faculty, and guests.  The committee will then question the candidate about the 

work and may suggest revisions.  The committee then is required to approve both the 

written document and the oral defense.  Usually, this approval is contingent on a final 

revision to be approved by the chair. 

 Electronic Theses and Dissertations.  After final approval of the document by the 

chair, the student will submit the document to the university in an electronic format.  

Guidelines for this process are found at 

http://www.marshall.edu/graduate/etd/importantstepspreparation.asp  Follow the steps 

listed on this page to submit your dissertation. 
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Submission of final manuscript. After all revisions have been made and 

approved, a final, clean copy may be submitted in a three ring binder with the title and 

the author on the spine to each committee member if they so request.  The chair may 

request a bound copy for his or her files or for the college archives. 

Applying for graduation.  At the beginning of the semester in which the student 

anticipates graduating, the student should complete the graduation application for the 

Ed.D. Degree found at: 

http://www.marshall.edu/graduate/forms/ApplicationforGraduation_0309.pdf. Submit 

this document and the appropriate fee to the Office of Graduate Records, Marshall 

University, 100 Angus E. Peyton Drive, South Charleston, WV 25303. 
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CHAPTER TWO:  MANUSCRIPT ORGANIZATION 

 
 
 Chapter Two explains the presentation of the content of the dissertation.  It 

provides an explanation and examples for the order in which the content is presented, the 

format for the content, and other suggestions for the presentation of the candidate’s 

research. 

Order 
Front Matter 
 

The front matter should be numbered at the center bottom with lower case Roman 

numerals and must be in this order: 

Title page  (required, number i, number suppressed) 

Abstract  (required, number ii, number suppressed) 

Dedication  (optional, if present start at Roman numeral iii) 

Acknowledgments (optional, if present, lower-case Roman numeral) 

Table of Contents (required, lower-case Roman numeral) 

List of Tables  (if present, lower-case Roman numeral) 

List of Figures  (if present, lower-case Roman numeral) 

Body   

 The body of the document must be numbered with consecutive Arabic numerals 

beginning with 1, and the chapters should be in this order unless a variation has been 

approved by the candidate’s dissertation chair: 

 Chapter One:  Introduction, Overview, Problem Statement 

 Chapter Two:  Review of the Literature 

 Chapter Three:  Research Methods 
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Chapter Four: Findings (It should be noted that for a qualitative research 

project, the findings may be divided into several chapters.) 

 Chapter Five:  Conclusions, Implications and Recommendations 

Back Matter 

 The back matter of the paper must be numbered with consecutive Arabic 

numerals continuing from the body and should be in this order: 

 References  (Required. A complete list of works cited) 

 Appendix  (Optional) 

 Glossary  (Optional) 

 Index   (Optional) 

 Curriculum Vitae (Required. A brief professional resume) 

 
Content Format for Front Matter 

 
Title Page 

 The title page must include the following information centered on the page (See 

example on page i): 

 1.   the full title of the dissertation 

 2. the candidate’s name as it appears in university records 

 3.   the institution of record and the college or school (Graduate College of 

Marshall University) 

 4.  degree statement 

 5.   committee list 

 6.  place of publication 

 7.  year of publication 
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 8. keywords listing 

 9. copyright statement  

 Title.  Choose the title carefully.  It should reflect accurately the content of the 

dissertation in order to inform scholars who may be interested in the topic, the methods, 

or the conclusions.  There is no limit to the number of words in the title, but it should not 

be effusive.  Be sure that the title is exactly the same on the title page, abstract, first page, 

and on all paperwork submitted.   

Candidate’s name.  The candidate’s name must be the same as it appears in 

university records and as the candidate plans to use professionally.  If there is a disparity, 

be sure to correct the university records before submitting the dissertation.  Use M.A. (or 

other appropriate degree for the candidate) on the copy submitted for the defense.  

Change it to Ed.D. on the final copy and in the ETD submission. 

 Institution of record.  The institution of record is Marshall University; the college 

is the Graduate College. 

 Degree statement.  Use the following wording, inserting the field (either 

Educational Leadership or Curriculum and Instruction).  Center the degree statement and 

type in inverted pyramid style. 

 
Dissertation submitted to the Faculty of the  
Graduate College of Marshall University 

in partial fulfillment of the 
requirements for the degree of 

 
Doctor of Education 

in 
Educational Leadership or Curriculum and Instruction 
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 Committee list.  List all members of the committee alphabetically, but with the 

chair, identified as such, first.  Use the full name of all committee members followed by 

their appropriate titles or degrees. 

Place of publication.  The place of publication is Huntington, West Virginia.  

Year of publication. The year of publication is the year in which you graduate. 

Keywords.  Electronic databases, citation indices, and bibliographies search by 

author’s name, title, and keywords.  Therefore, it is important to choose terms that 

accurately reflect the content of the dissertation and the discipline.  The ERIC thesaurus 

with a list of suggested key words by academic discipline can be obtained from the 

reference desk at the Marshall University Library and from EBSCO’s ERIC database or 

from 

http://www.eric.ed.gov/ERICWebPortal/Home.portal?_nfpb=true&_pageLabel=Thesaur

us&_nfls=false   

Copyright statement.  Doctoral candidates should apply for a copyright.  This can 

be done through the electronic submission process.  To apply for a copyright follow the 

directions during submission. 

Abstract 

 The purpose of the abstract is to give a concise summary of the dissertation so 

that readers will be able to understand the essence of the paper in order to determine 

whether it is advisable to read the entire manuscript.  The maximum length for the 

abstract is 350 words (2450 characters).  The heading ABSTRACT should be centered at 

the top of the page; four lines below the heading, the exact title of the dissertation should 

be centered with the proper capitalization (The Exact Title), followed by the full name 



 

 12

of the candidate as it appears on the title page. The body of the abstract  should be left-

justified and single-spaced and should not exceed one page.  The content should briefly 

summarize, without subheadings, the problem statement, methods, results, and 

conclusions. (See example on page ii). 

Dedication 

 This page is optional.  The author may want to dedicate the work professionally to 

a special mentor or personally to acknowledge a special relationship.  If one chooses to 

do this, the wording should be brief and simple. The heading DEDICATION (in all 

capital letters) is centered at the top of the page; the text begins four lines below, with the 

page number in lower-case Roman numerals in the bottom center. (See example on page 

iii). 

Acknowledgments 

 This page is optional.  The author may want to acknowledge others’ assistance 

and support.  This may be for special academic assistance, for unusual permissions 

granted, or for special personal support.  Again, one should avoid elaborate language and 

make the wording brief and simple.  The heading ACKNOWLEDGMENTS (in all 

capital letters) is centered at the top of the page; the text begins four lines below, with the 

page number in lower-case Roman numerals in the bottom center.  (See example on page 

iv).  

Table of Contents 

 The table of contents is required in all dissertations.  Microsoft Word, the 

recommended word processing software, allows you to mark each chapter heading and 

subsection in the text and then generate a table of contents with correct page numbers.  It 
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is essential that the numbering of the entries in the table of contents be consistent with the 

numbering in the text.  For ease of reading, use dot leaders in the table of contents.  The 

heading TABLE OF CONTENTS (in all capital letters) is centered at the top of the 

page; the listing begins four lines below, with the page number in lower-case Roman 

numerals in the bottom center.  (See TABLE OF CONTENTS on page v). 

List of Tables, Figures 

 If the dissertation includes at least one figure or table, one must include an 

appropriate list including the title of the table or figure and the page on which it is 

located.  Use the table and figure captions from the text and be sure all captions and 

numbering correspond to those within the text.  The easiest way to generate these lists is 

to use the word processor to create a secondary table of contents.  The appropriate 

heading (in all capital letters) is centered at the top of the page; the text begins four lines 

below, with the page number in lower-case Roman numerals in the bottom center.  (See 

sample in Appendix A). 

Content Format for the Body of the Paper 
 

 For most dissertations, the body will have five chapters. However, this may not be 

true in a paper that presents qualitative research.  In this instance, the nature of the 

research will determine the number of chapters.  Students must discuss with their chair 

how best to present their work.  Generally, in both traditions the first three chapters are 

similar.  In the prospectus these three chapters are presented using the future tense.  At 

the conclusion of the research, these chapters may be expanded and must be revised using 

the past tense. 
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 In addition to general titles, like CHAPTER ONE, the chapters need descriptive 

titles as well (e.g., CHAPTER FIVE: CONCLUSIONS AND IMPLICATIONS).  The 

chapter titles should be bold in all capitals and should be centered on the page with the 

chapter number on the first line followed by a colon and the descriptive title.  Chapters 

should be numbered with the word spelled out. 

Chapter One 

 In both quantitative and qualitative work, the first chapter is an introduction to the 

research. While the order for the content is determined by the type of study, the student 

presents an overview of the work including the rationale for the study with supporting 

literature and the theory on which the study is grounded, the problem statement, the 

research questions, a definition of terms, including operational definitions of variables 

when appropriate, a brief summary of the methods used, a discussion of the limitations 

and assumptions of the study, and a presentation of the significance of the study.   

Chapter Two 

 In both quantitative and qualitative work, the second chapter is an exhaustive 

review of the professional literature related to the research topic.  One will not only report 

what one has read, but one must “synthesize and critically analyze the literature” (Cone 

&Foster, 1997, p. 112).  Cone and Foster identified these steps in reviewing the literature: 

 1. Locate relevant literature  

  a. Identify key authors and journals 

  b. Use bibliographic reference sources 

  c. Use computerized literature searches 

  d. Write for reprints and preprints 
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  e. Look at literature from other disciplines 

  f. Scan the tables of contents from other journals 

  g. Use reference lists   

  h. Use primary sources 

  j. Avoid the popular press 

 2.  Critically read what you found 

 3.  Investigate length and format parameters for the literature review 

 4.  Make a preliminary outline 

 5.  Limit the scope of your review 

 6.  Organize the literature (Cone and Foster suggested these possible formats.) 

  a. by related independent variables 

  b. by related dependent variables 

  c. by type of design 

  d. by theoretical premises 

  e. general to specific to the study rationale 

 7.  Synthesize and critically analyze the literature 

 8.  Be careful not to plagiarize 

Chapter Three 

 In both quantitative and qualitative work, the third chapter is an explanation of the 

methods used in conducting the research.  Topics that may be included are the research 

design, the population and sample, instrumentation (source, validation, reliability, 

scoring), data collection and analysis, statistics, time schedule, personnel included, and 

facilities used. 
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Chapter Four 

 The purpose of the fourth chapter is to present the research findings.  In a 

qualitative paper, the format for this chapter will vary.  It may also be necessary to have 

more than one chapter to present the research findings.  In a quantitative paper, the 

researcher will present the data collected and a statistical analysis of the data.   The 

research will also summarize the findings for each of the research questions or 

hypotheses as well as any ancillary findings.  

Presentation of tables.  The term “table” is used to designate tabulated numerical 

data used in the body of the dissertation or in the appendices.  Tables consist of an 

arrangement of facts, figures, and values in an orderly sequence, usually in rows and 

columns.  “A well-crafted table can assist readers immeasurably in understanding your 

results.  Skill in constructing such tables takes a good deal of practice” (Cone & Foster, 

1997, p. 224).  Use the APA guidelines for the proper conventions in the preparation and 

presentation of tables.  In order to present a table on one page, one may reduce the font if 

necessary or may place the table in landscape orientation. 

Presentation of figures.  The term “figure” is used to designate any type of 

illustration other than a table used in the body of the dissertation and in the appendices.  

This includes material such as matrices, charts, graphs, maps, photographs, plates, 

drawings, diagrams, etc.  All figures must be computer-generated or drawn in dark, 

opaque fashion and be of sufficient size to be readable.  As with tables, use the APA 

guidelines for the preparation and presentation of figures.   



 

 17

Chapter Five 

 The purpose of the final chapter is to summarize the work and present the 

researcher’s conclusions.  The implications and limitations of the study and the 

recommendations for further study are presented here.  The chapter generally is 

organized in this manner: 

 1.  Purpose—restate the hypotheses or research questions and describe the results 

clearly. 

 2.  Population/sample—briefly recapitulate the demographic data that describe the 

participants.  Use prose, no tables. 

 3.  Methods—briefly describe the procedures used. 

 4.  Findings—clearly summarize the findings, including ancillary findings using 

prose and as little statistical jargon as possible. 

 5.  Conclusions—relate the findings to the literature and interpret what the 

findings mean. 

 6.  Implications—discuss the implications of the study in terms of professional 

practice and in relation to bodies of knowledge relevant to the study.  

7.  Recommendations—make recommendations for further study.  These 

recommendations might include replication of the study, replication with other data 

sources or a different population, the addition of other variables, training or screening of 

subjects, or a deeper analysis of a finding. 

Language 

 The dissertation must be written in standard English with attention to proper 

usage and grammar.  The hallmark of a well-written document is clarity, and while the 
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tone may vary, it generally should be formal and scholarly.  For example, in formal 

language one should not use contractions except in direct quotes.  Be interesting, but 

avoid flowery language that may detract from the content of your research.  Suggestions 

for assisting the student with language may be found in Appendix C. 

 Bias in language.  Avoid language that implies bias in gender, sexual orientation, 

racial or ethnic group, religion, disability, or age.  The APA manual (2010) recommends 

that one should use language that shows respect both for the participants in the study and 

the readers of the study.  (See Appendix D).   

 Tense.  Be consistent in the use of tense.  Use past or past perfect tense to discuss 

the literature, methods, and results.  It is permissible to use present tense to discuss the 

student’s own results and the conclusions based on his or her results.  In the prospectus, 

use the future tense, but be sure to change it to past or past perfect after the research is 

concluded. 

 Voice.  Generally one should use the active voice (The researcher found—rather 

than—it was found by the researcher.)  The one exception is when the focus is on the 

work itself rather than the author (This style guide was developed…) 

 Person.  In formal writing one avoids the use of first person or second person 

pronouns except in direct quotations.  However, in the qualitative research tradition the 

use of these pronouns is preferred. 

Content Format for the Back Matter 

References 

 All scholarly references should be properly cited using inter-textual parenthetical 

notes with a complete list of references located at the end of the paper.  The heading 
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REFERENCES (in all capital letters) is centered at the top of the page; the list of 

references begins four lines below, with the page number in the bottom center.  (See 

REFERENCES this document). The alphabetical references should be double-spaced in 

hanging indent form and should include only references to cited sources. 

Appendix 

 Documents that support and explain the research methods should be included as 

appendices.  These might include survey instruments, IRB letters, letters requesting 

participation, reference materials, transcripts of interviews, and other addenda that are not 

integrated in the text.  If one has multiple appendices, they should be labeled 

consecutively (APPENDIX A, APPENDIX B, etc.) in all capital letters and should be 

arranged in the order in which they appear in the text.  Each appendix should be preceded 

by an introductory page that gives the appendix label and the name of the item.  All 

appendices should be included in the table of contents listed separately as a subdivision 

under the heading APPENDICES.  Generally appendices should follow the margin and 

font guidelines for the paper, but if an original document was prepared in a typeface 

different from the dissertation, the original form should be used.  It is important to note 

that no signatures should be reproduced on any document. (See Appendices in this 

document). 

Glossary 

 A glossary is not typically included, but if one chooses to use a glossary, the 

definitions should be single-spaced, with double-spacing between entries.  Terms should 

be listed alphabetically.  Proper nouns should be capitalized and foreign words should be 
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in italics.  The heading GLOSSARY (in all capital letters) is centered at the top of the 

page; the glossary begins four lines below, with the page number in the bottom center. 

Index   

 An index is not typically included, but if one chooses to use an index, the entries 

should be single-spaced.  The heading INDEX (in all capital letters) is centered at the top 

of the page; the index begins four lines below, with the page number in the bottom center. 

(See Index in this document). 

Curriculum Vitae (C. V.) 

 The curriculum vitae is a brief professional resume including the candidate’s 

education, professional credentials, and work experience.  It is the final page in the 

document and generally is limited to one page. One should not include personal contact 

information in the C. V. The heading CURRICULUM VITAE (in all capital letters) is 

centered at the top of the page; the resume begins four lines below, with the page number 

in the bottom center.  (See sample in Appendix A). 
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CHAPTER THREE:  FORMAT AND APPEARANCE OF THE DOCUMENT 

 
 This chapter provides guidance to the student for the appearance of the paper.  It 

includes information regarding layout and format, word processing recommendations, 

and proper form for citations and headings. 

Copy Quality 

 The document should be submitted to the committee on white, high-quality paper.  

The paper size must be 8 ½ inches by 11 inches.  The manuscript must be printed on only 

one side of the paper.  Paper and electronic copies must be clean, clear, and uniform with 

high contrast.  

Word Processing Requirements 

 The document must be prepared with a computer and an appropriate word 

processing program.  At Marshall University, the supported word processing program is 

Microsoft Word.  See Appendix E for assistance in word processing. 

Spacing, Fonts, and Type Size 

 The required font size is 12 characters per horizontal inch.  The required font style 

is Times New Roman.  If necessary, different font sizes or styles may be used within 

headings, tables, figures, and appendices or for commonly accepted symbols.  All straight 

text should be double-spaced.  Paragraph indentation should be by a tab set at seven 

spaces. 

Page Format 

Margins   

Each page should have a 1.5” left hand margin, and at least a 1” margin on the 

top, bottom, and right side.  Please note that all pages, including the title page, 
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illustrations, table, appendices, and curriculum vitae, must meet these requirements. The 

margins for the body of the paper should be left-justified, but exceptions may be made for 

special pages such as those previously mentioned. 

Page Numbers   

Page numbers must be placed at the bottom center of every page, including any 

blank pages.  Pages should be numbered consecutively and students should not use a 

secondary number system within chapters.  The page numbers for the front matter in the 

document should be lower-case Roman numerals; the body of the text and any back 

matter should be consecutive Arabic numerals beginning with Arabic numeral 1 on the 

first page of the body. 

Seriation 

 When one is enumerating elements is a series, there are three formats:  (a) within 

a paragraph or a sentence, use lowercase letters in parentheses, (b) for separate items in 

series, use an Arabic numeral followed by a period (See page 9), and (c) use a bulleted 

list as described in the APA Manual (2010).  In any enumerated series, the items should 

be parallel, both conceptually and structurally. 

Permission for Quoting Copyright Materials 

 The U.S. Copyright Act of 1976 established the concept of “fair use” of copyright 

material in published work, but it does not provide absolute guidelines. However, the use 

of a complete unit (a photograph, map, poem, etc.) or of quoted material that exceeds 200 

words requires the author’s permission.  When in doubt, seek permission.  It is usually 

granted.  Copies of written permissions should be included in an appendix.   
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Citations 

 APA style (6th edition) uses the author-date inter-textual method of citation; that 

is, the surname of the author and the year of publication are inserted in the text at the 

appropriate point.  For example, Sisco (2000) found.... Or In a recent study (Sisco, 2000) 

it was discovered..... (See Appendix D).  Of course, one must cite the source for any idea, 

organizational strategy or concept to which one refers. If one uses the exact words or 

closely paraphrases the work, cite it with the author’s name, the year of publication, and 

the page number from whence the quotation came.  If the quotation is less than 40 words, 

use quotation marks and cite it in the text.  If it is more than 40 words, use a block quote 

and do not use quotation marks.  Block quotes should be indented seven spaces and 

double-spaced.  

Headings 

 Headings and subheadings show how the paper is organized.  They are like an 

outline in that they establish a hierarchy and help readers understand the relationships of 

the parts of the paper.  As in an outline, at any level one does not divide a topic unless 

there are at least two subdivisions.  The faculty strongly suggest outlining the paper using 

the headings as topics.  This process is a useful tool to help the author be sure the 

relationships among topics are clear.  Although the outline topics and the headings will 

be parallel, do not use numbers or letters with the headings in the paper.  GSEPD also 

does not use “running heads” in a dissertation. Students are reminded that Microsoft 

Word, the recommended word processing program, uses headings to create the table of 

contents and by defining the headings in the Styles and Format section, one can easily 

create the table of contents in the document.   
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APA provides for five levels of headings (p. 113), but GSEPD has adopted a 

simpler guide with four headings.  Most dissertations use only four headings, although 

one should use as many levels of headings as needed.  If more than four levels are 

needed, see the APA manual and Appendix D.  This field guide has used four levels of 

headings as an example for the student to follow. Use bold print for all headings. 

The four levels of headings are: 

CENTERED UPPERCASE HEADING (HEADING ONE) 

Centered Uppercase and Lowercase Heading (Heading Two) 

Flush Left, Italicized, Uppercase and Lowercase Side Heading (Heading Three) 

 Indented, italicized, lowercase paragraph heading ending with a period (Heading 

Four). 

 Heading one.  Heading one is used for the title of a major section or chapter.  Begin 

each chapter or section on a new page with the section name or chapter number and name 

centered in all capitals.  For example, 

CHAPTER ONE:  HEADING ONE 

 Heading two.  Do not use a heading for the introduction to the chapter (see page 

21), but for each of the main topics that follow, use heading two. Use heading two only if 

there are at least two main topics in the chapter.  Each heading two is centered and the 

primary words are capitalized.  Double-space after the heading.  The text following a 

heading two is left-justified and indented. For example,  

Main Topic (Heading Two)  

Heading three.  If under any heading two, it is necessary to subdivide to clarify 

the relationship of ideas, use heading three. Use heading three only if there are at least 

two divisions in a main topic.  A heading three is italicized and left-justified and the 
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primary words are capitalized. Double-space after the headings.  The text following a 

heading three is left-justified and indented.  For example, 

Subheading (Heading Three) 

 Heading four.  If under any heading three, it is necessary to subdivide to clarify 

the relationship of ideas, use heading four. Use heading four only if there are at least two 

subtopics in the chapter.  A heading four is indented and italicized and, unless it is a 

proper noun, only the initial word is capitalized.  A heading four is followed by a period 

and the text begins after the period.  For example, 

Subheading (heading four). Text follows. 

 If it is necessary to use an additional level of heading, see the APA manual for 

guidance.  Remember, the purpose of headings is to assist the reader in understanding the 

organization of the document and the relationship of ideas in the work. 
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APPENDICES 

 
 

Appendix A: Sample pages 
    

List of Tables 
 
Curriculum Vitae    

 
Appendix B:  Institution Review Board Sample Letters  
 
Appendix C: Diversified Styles for Dissertation/Project Writing 
 
Appendix D: Excerpts from Writing Manuscripts Using APA Style (6th Edition) 
 
Appendix E:  Dissertation Formatting Tips—Using Microsoft Word 
 
 

 

 

(Note: The appendices in your document will vary based on the specific needs of your research. 
This page is intended only to demonstrate the general format for presenting your appendices.)
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APPENDIX A:  SAMPLE PAGES 

 
LIST OF TABLES 

CURRICULUM VITAE 
 
 
 
 
 
 
 
 
 

(Note: These are sample pages to be used as you prepare the specific items for your document. 
In your document they will NOT be located in the appendices. See Chapter Two in this document 

for appropriate placement.)
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LIST OF TABLES 
 

Table 1  Delphi Study Participation Record Page 105 

Table 2 Consensus Results of Expert Principals’ Opinions Concerning 
Contemporary Changes in the  Role of the Secondary Principal 

 

Table 3 Consensus Results of Expert Principals’ Opinions Concerning 
the Current Role of the Secondary Principal 

Page 111 

Table 4 Consensus Results of Expert Principals’ Opinions Concerning 
the Preferred Future of the Secondary Principal 

Page 109 

Table 5 Results of Sample Principals’ Opinions Concerning 
Contemporary Changes in the  Role of the Secondary Principal 

Page 116 

Table 6 Results of Sample Principals’ Opinions Concerning the Current 
Role of the Secondary Principal 

Page 118 

Table 7 Results of Sample Principals’ Opinions Concerning the 
Preferred Future of the Secondary Principal 

Page 120 

Table 8 Comparison of Results of Expert and Sample Principals’ 
Opinions Concerning Contemporary Changes in the  Role of the 
Secondary Principal 

Page 123 

Table 9 Comparison of Results of Expert and Sample Principals’ 
Opinions Concerning the Current Role of the Secondary 
Principal 

Page 125 

Table 10 Comparison of Results of Expert and Sample Principals’ 
Opinions Concerning the Preferred Future of the Secondary 
Principal 

Page 127 

Table 11 One-Way Analysis of Variance Relationship Between Identified 
Demographic Factors and the Sample Principals’ Level of 
Confidence in the Descriptors of the Contemporary Changes in 
the Secondary Principalship 

Page 129 

Table 12 One-Way Analysis of Variance Relationship Between Identified 
Demographic Factors and the Sample Principals’ Level of 
Confidence in the Descriptors of the Current Role of the 
Secondary Principal 

Page 130 

Table 13 One-Way Analysis of Variance Relationship Between Identified 
Demographic Factors and the Sample Principals’ Level of 
Confidence in the Descriptors of the Preferred Future of the 
Secondary Principal 

Page 131 

Table 14 One-Way Analysis of Variance Relationship Between Medium of 
Response (Electronic or Postal) and the Sample Principals’ 
Level of Confidence in the Descriptors of the Contemporary 
Changes in the Role of the Secondary Principal 

Page 132 

Table 15 One-Way Analysis of Variance Relationship Between Medium of 
Response (Electronic or Postal) and the Sample Principals’ 
Level of Confidence in the Descriptors of the Current Role of the 
Secondary Principal 

Page 133 
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2003-2005 Assistant Superintendent, Kanawha County Schools, Charleston, WV 
2005-Present Superintendent, Lincoln County Schools, Hamlin, West Virginia 
 
HONORS AND RECOGNITION 
 
1994  West Virginia Teacher of the Year 
1996  Chair, West Virginia Vice-principals’ Conference 
1998  West Virginia Association of Secondary School Principals Executive Board 
1999`  Principal West Virginia School of Excellence 
2004  Kanawha County Schools Educator of the Year        
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APPENDIX B:  INSTITUTIONAL REVIEW BOARD 

(from http://www.marshall.edu/research/ori/IC%20Templates.asp) 
 

Informed Consent to Participate in a Research Study Template 
 

Anonymous Survey Consent Template  
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Marshall University 
Informed Consent Template1 

IRB#2 
 
Instructions: (Delete this instructional page before submission of consent) 

 This template is designed to provide assistance and guidance in the construction of 
research informed consent documents.  While it addresses many issues, it does not 
address every possible situation or issue that may arise.  Investigators should use this 
document for what it is, a template.  Investigators must include all study specific 
information that a potential research subject should be aware of in order to make an 
informed, voluntary decision about taking part in the study. 

 The goal of the informed consent process is to provide people with sufficient information 
for making informed choices.  The informed consent form provides a summary of the 
clinical study and the individual’s rights as a research participant.  This template for the 
informed consent form is only one part of the larger process of informed consent. 

 The descriptions and information should be in lay language, defined as language 
understandable to the people being asked to participate (usually 6th to 8th grade).  The 
final version should be checked for reading level. 

 Individuals involved in the study should be referred to as subjects or participants not 
patients. 

 The use of second person (e.g., “You will receive…”) is preferred; the use of the first 
person (e.g., “I understand that…”) should not be used. 

 Pages should be numbered and a section included for the subject to initial at the bottom 
of each page that does not have signatures on it (i.e. “Initial ______”).  This way they can 
know that changes cannot be made to any page without their knowledge. 

 For minimal risk studies there needs to be language that describes: 
o An explanation as to whether any compensation is available if injury occurs. 
o If compensation is available if injury occurred, an explanation as to what it consists of 

or where further information can be obtained. 
o An explanation as to whether any medical treatments are available if injury occurs. 
o If medical treatments are available if injury occurs, an explanation as to what they 

consist of or where further information can be obtained. 
 If the following criteria are applicable then they should be included in the consent: 

o A statement that if the participant is or becomes pregnant, the particular treatment or 
procedure might involve risks to the embryo or fetus, which were currently 
unforeseeable. 

o Anticipated circumstances under which the participant’s participation might be 
terminated by the investigator without regard to the participant’s consent. 

o The consequences of a participant’s decision to withdraw from the research. 
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o Procedures for the orderly termination of participation by the participant. 
o A statement that significant new findings developed during the course of the research 

which might relate to the participant’s willingness to continue participation will be 
provided to the participant. 

 The contents of this template were derived from the Code of Federal Regulations (Title 
45, Part 46) Section 46.116 General Requirements for Informed Consent. 

 
Subject’s Initials ________ 

 
 

Revised May 11, 2006 
1 Adapted From National Cancer Institute Model 
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Informed Consent to Participate in a Research Study 
 
 

Study Title 
First Name Last Name, Degree, Principal Investigator 

 
 

Introduction 
 

You are invited to be in a research study.  Research studies are designed to gain scientific 
knowledge that may help other people in the future.  You may or may not receive any benefit 
from being part of the study.  Your participation is voluntary.  Please take your time to make 
your decision, and ask your research investigator or research staff to explain any words or 
information that you do not understand. 
 
 

Why Is This Study Being Done? 
 

The purpose of this study is to…[Give brief explanation as to why study is being done.] 
 
 

How Many People Will Take Part In The Study? 
 

About [state total accrual goal here] people will take part in this study.  A total of [enter 
maximum number] subjects are the most that would be able to enter the study. 
 
 

What Is Involved In This Research Study? 
 

[Provide a simplified description of what will be required of them to participate in this study and 
what will happen during the study.] 
 
[Identify any procedures that are experimental…(that is, what is being done as part of the 
research and what would be done anyway)] 
 
 

What about Alternative Procedures? 
 

[List here any alternative procedures or courses of treatment that might be advantageous to the 
participant.  This can also include the alternative such as alternate course credit.  If there are no 
alternatives, then you can omit this section.] 
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How Long Will You Be In The Study? 
 

You will be in the study for about [months/weeks, until a certain event]  
[Where appropriate state the duration of long-term follow up.] 
 
You can decide to stop participating at any time.  If you decide to stop participating in the study 
we encourage you to talk to the study investigator or study staff as soon as possible. 
 
The study investigator may stop you from taking part in this study at any time if he/she believes 
it is in your best interest; if you do not follow the study rules; or if the study is stopped. 
 
 

What Are The Risks Of The Study? 
 

[Use whichever statement is applicable:] 
 
There are no known risks to those who take part in this study. 
 
[Or] There may be these risks: 
 

 [List and explain the physical, psychological, and social risks/discomforts and when 
known indicate the relative chances for each.] 

 
 [When applicable, explain any risks that might be associated with a breach of 

confidentiality, including risks to employability, insurability, or criminal and civil 
liabilities.] 

 
 
There may also be other side effects that we cannot predict.  You should tell the researchers if 
any of these risks bother or worry you. 
 
 

Are There Benefits To Taking Part In The Study? 
 

If you agree to take part in this study, there may or may not be direct benefit to you.  We hope 
the information learned from this study will benefit other people in the future.  The benefits of 
participating in this study may be: [Describe the benefits an individual subject could reasonable 
expect from participating in the study.] 
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What About Confidentiality? 
 

We will do our best to make sure that your personal information is kept confidential.  However, 
we cannot guarantee absolute confidentiality.  Federal law says we must keep your study records 
private.  Nevertheless, under unforeseen and rare circumstances, we may be required by law to 
allow certain agencies to view your records.  Those agencies would include the Marshall 
University IRB, Office of Research Integrity (ORI) and the federal Office of Human Research 
Protection (OHRP).  This is to make sure that we are protecting your rights and your safety.  If 
we publish the information we learn from this study, you will not be identified by name or in any 
other way.   
 
[If research is FDA-regulated, the following template language is required] Because this 
research is regulated by the Food and Drug Administration (FDA), the FDA may choose to 
inspect and copy medical or research records that identifies individual research subjects. 
  
 

What Are The Costs Of Taking Part In This Study? 
 

[Use one of the following paragraphs as appropriate:] 
 
There are no costs to you for taking part in this study.  All the study costs, including any study 
tests, supplies and procedures related directly to the study, will be paid for by the study. 
 
Or 
 
There will be some cost to you for taking part in this study.  You will have to pay about 
$[amount] for these study tests, supplies and procedures. 
 
 

Will You Be Paid For Participating? 
 

[If compensation for participation is available, list conditions, such as dollar amount per visit or 
payment upon study completion.] 
You will be paid $[amount] if you complete all the scheduled study visits.  If you withdraw for 
any reason from the study before completion you will be paid $[amount] for each complete 
study visit. 
 
[If no payment for participation is available, you could use the following:] 
You will receive no payment or other compensation for taking part in this study. 
 

Who Is Sponsoring This Study? 
 

[If there is no sponsor then omit this section.  If there is a sponsor then:] 
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This study is being sponsored by [Name of sponsor].  The sponsor is providing money or other 
support to help conduct this study.  The researchers do not, however, hold a direct financial 
interest in the sponsor or the product being studied. 
 
 

What Are Your Rights As A Research Study Participant? 
 

Taking part in this study is voluntary.  You may choose not to take part or you may leave the 
study at any time.  Refusing to participate or leaving the study will not result in any penalty or 
loss of benefits to which you are entitled.  If you decide to stop participating in the study we 
encourage you to talk to the investigators or study staff first. 
 
 

Whom Do You Call If You Have Questions Or Problems? 
 

For questions about the study or in the event of a research-related injury, contact the study 
investigator, Name at Telephone number (also include after hours number).  You should also call 
the investigator if you have a concern or complaint about the research. 
 
For questions about your rights as a research participant, contact the Marshall University IRB#2 
Chairman Dr. Stephen Cooper or ORI at (304) 696-4303.  You may also call this number if: 

o You have concerns or complaints about the research. 
o The research staff cannot be reached. 
o You want to talk to someone other than the research staff. 

 
 
You will be given a signed and dated copy of this consent form. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 38

SIGNATURES 
 
You agree to take part in this study and confirm that you are 18 years of age or older.  You have 
had a chance to ask questions about being in this study and have had those questions answered.  
By signing this consent form you are not giving up any legal rights to which you are entitled. 
 
 
________________________________________________ 
    Subject Name (Printed) 
 
 
________________________________________________            _________________ 
    Subject Signature                                                                                         Date 
 
 
________________________________________________ 
    Person Obtaining Consent (Printed) 
 
 
________________________________________________            _________________ 
     Person Obtaining Consent Signature                                                           Date 
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Anonymous Survey Consent (SAMPLE) 
  
You are invited to participate in a research project entitled “(title)” designed to analyze (state the 
purpose of the study).  The study is being conducted by (principal investigator) and (list other 
investigator, if applicable) from (insert institution).  This research is being conducted as part of 
the (thesis/dissertation/class requirements) for (student investigator). 
  
This survey is comprised of (state what the surveyor will be expected to complete and how long 
it will take the participant to complete the survey).  Your replies will be anonymous, so do not 
put your name anywhere on the form.  There are no known risks involved with this study.  
Participation is completely voluntary and there will be no penalty or loss of benefits if you 
choose to not participate in this research study or to withdraw.  If you choose not to participate 
you may either return the blank survey or you may discard it.  You may choose to not answer 
any question by simply leaving it blank.   Returning the survey (provide return instructions) 
indicates your consent for use of the answers you supply.  If you have any questions about the 
study you may contact (principal investigator) at (phone number), (student investigator) at 
(phone number).   
 
If you have any questions concerning your rights as a research participant you may contact the 
Marshall University Office of Research Integrity at (304) 696-4303. 
  
By completing this survey and returning it you are also confirming that you are 18 years of age 
or older. 
 
Please keep this page for your records. 
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Online Anonymous Survey Consent  
  
You are invited to participate in a research project entitled “(title)” designed to analyze (state the 
purpose of the study).  The study is being conducted by (principal investigator) and (list other 
investigator, if applicable) from (insert institution) and has been approved by the Marshall 
University Institutional Review Board (IRB).  This research is being conducted as part of the 
(thesis/dissertation/class requirements) for (student investigator). 
  
This survey is comprised of (state what the surveyor will be expected to complete and how long 
it will take the participant to complete the survey).  Your replies will be anonymous, so do not 
type your name anywhere on the form.  There are no known risks involved with this study.  
Participation is completely voluntary and there will be no penalty or loss of benefits if you 
choose to not participate in this research study or to withdraw.  If you choose not to participate 
you may either return the blank survey or you may discard it.  You may choose to not answer 
any question by simply leaving it blank.   Once you complete the survey you can delete your 
browsing history for added confidentiality.  Completing the on-line survey indicates your 
consent for use of the answers you supply.  If you have any questions about the study or in the 
event of a research related injury, you may contact (principal investigator) at (phone number), 
(student investigator) at (phone number).   
 
If you have any questions concerning your rights as a research participant you may contact the 
Marshall University Office of Research Integrity at (304) 696-4303. 
  
By completing this survey you are also confirming that you are 18 years of age or older. 
 
Please print this page for your records. 
 
If you choose to participate in the study you will find the survey at www.xxxxxxx.com  
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APPENDIX C:  WRITING GUIDE 
 

DIVERSIFIED STYLES FOR DISSERTATION/PROJECT WRITING 
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Used with the permission of Dr. Waynne B. James 
Adult, Career, and Higher Education, University of South Florida 

 
DIVERSIFIED STYLES 

 FOR DISSERTATION/PROJECT WRITING 
Waynne B. James 

 
 When citing sources such as (Smith, 2006), try to vary your style of writing.  The 
following examples may give you some ideas. 

 
Smith (2006) accepted 
     “       “       accounted for 
     “       “       acknowledged 
     “       “       admitted 
     “       “   administered 
     “       “       agreed 
     “       “       approached  
     “       “       argued that 
     “       “       ascertained 
     “       “       asserted  
     “       “       believed 
     ”       “       calculated 
     “       “       catalogued 
     “       “       cautioned  
     “       “       characterized 
     “       “       checked 
     “       “       cited 
     “       “       chided 
     ”       “       clarified 
     ”       “       compared the mean scores of 
     “       “       compiled 
     “       “       complained 
     “       “       concluded 
     “       “       conceived of 
     “       “       conducted a study that 
     “       “       considered 
     “       “       contended 
     “       “       crafted 
     “       “       created 
     “       “       demonstrated 
     “       “       denoted 
     “       “       described 
     “       “       designated 
     “       “       disclosed 
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     Smith (2006) found that 
     “       “       distinguished between 
     “       “       evaluated 
     “       “       examined 
     “       “       exhibited 
     “       “       experimented with  
     “       “       extended the notion 
     “       “       felt 
     “       “       filed 
     “       “       formulated 
     “       “       fostered 
     “       “       further showed 
     “       “       generated the 
     “       “       has shown 
     “       “       held that since 
     “       “       hinted that 
     “       “       implied that 
     “       “       indexed 
     “       “       indicated 
     “       “       initiated 
     “       “       intimated 
     “       “       inventoried 
     “       “       investigated 
     “       “       investigated the relationships that 
     “       “       judged 
     “       “       listed 
     “       “       looked at (into) 
     “       “       made the distinction 
     “       “       manifested  
     “       “       named 
     “       “       noted 
     “       “       noticed that 
     “       “       observed that 
     “       “       pointed out 
     “       “       presented 
     “       “       proposed 
     “       “       questioned 
     “       “       quoted 
     “       “       raised the question about 
     “       “       recorded 
     “       “       referred to 
     “       “       researched 
     “       “       responded to 
     “       “       revealed 
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Smith (2006)  reviewed 
     “       “       scheduled 

       “       “       scrutinized 
     “       “       showed that 
     “       “       signified 
     “       “       specified 
     “       “       stated 
     “       “       submitted 
     “       “       supported 
     “       “       surmised that 
     “       “       tabulated 
     “       “       tallied 
     “       “       theorized 
     “       “       thought 
     “       “       warned 
     “       “       wrote 
 

 When referring to tables in the dissertation, you may want to use the following: 
 
In Table 1, data are presented. . . . 
 
According to the data in Table 2 . . . 
 
The studies that had been conducted are summarized in Table 3. . . 

. 
   A comparison of. . . is presented in Table 4. 

 
The results of the five ANOVAS are presented in Table 5. 
 
The data cited in Table 6 reveal that. . . . 
 
The data in Table 7 indicate that. . . . 
 
On the basis of the data in Table 8, the. . . . 
 
A study of Table 9 indicates. . . . 
 
Table 10 represents an attempt to. . . . 
 
An inspection of the data in Table 11 allows the generalization that. 

. . . 
   According to the findings in Table 12, the. . . . 
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The ratios listed in Table 13 provide a basis for making the 
statement that. . . . 

 
A Mann-Whitney U analysis of the data in Table 14 shows a. . . . 
Table 15 contains the data which were taken from. . . . 
 
Four of the F ratios which are listed in Table 16 are in the region of 

rejection. 
 

   A review of the data listed in Table 17 (Appendix 4) indicates that. . 
. . 
   Five significant differences were calculated and reported as t 
values in Table 18. 

 
A study of the ratios in Table 19 suggests that seven t's are 

associated with the region of rejection. 
 
An inspection of Table 20's F ratios reveals four values which 

exceed the critical values of F. 
 
None of the t ratios in Table 21 exceed the critical value of t (2.09) 

at the .05 level of significance. 
 
A review of Table 22's entries suggests. . . . 
 
A study related to the F values which are enumerated in Table 23. . 

. 
 A review of the correlation coefficients which are listed in Table 24 reveals three 
significant relationships: . . .  

 
The responses to Question 2 "How many hours of course work did 

you take?" are presented in Table 25. 
 
See Table 26 for. . . . 

 
NEVER write: Table 27 shows. . . . 

Tables are inanimate objects; therefore, they cannot "do" 
things (i.e., show, present, etc.) 

 
Developed by W. James,  

Adult, Career, and Higher Education 
University of South Florida 
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APPENDIX D:  APA STYLE 

 
EXCERPTS FROM WRITING MANUSCRIPTS USING APA STYLE (6TH EDITION) 
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APPENDIX D 
 

Used with the permission of Dr. Michael W. Galbraith, 

Graduate School of Education and Professional Development, 

South Charleston, WV 25303 

 

WRITING MANUSCRIPTS USING APA STYLE (6th Edition) 

 Abstract 

The purpose of these guidelines is to provide to you a brief description of the most salient 

information as it relates to writing manuscripts using the Publication Manual of the American 

Psychological Association (APA) (6th edition).  For our purpose, information on the title page, 

abstract, spacing, margins, page numbers, quotations, headings, citations, and references will be 

provided, as well as some brief comments on being sensitive in your writing process. If other 

questions arise as you write your manuscript, you should refer to the manual that addresses those 

specific concerns. 

--------------- 

Dr. Michael W. Galbraith, Graduate School of Education and Professional Development, 

South Charleston, WV 25303 

 January 2010 

The Title Page 

 A title should summarize the main idea of the paper.  The title should be fully explanatory 
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when standing alone; that is it should be a concise statement of the main topic.  The title page 

should contain three elements: title, author, and affiliation.  If you use a running head that will 

also appear on the title page, as well as the page number 1, placed in the upper right-hand corner 

of the page.  The title should be typed in uppercase and lowercase letters and centered on the 

page.  Your name should be typed in uppercase and lowercase letters, centered on the page, and 

one double-spaced line below the title.  Your affiliation should be typed in uppercase and 

lowercase letters and centered under your name. 

   Abstract 

 Some of the papers that you will write require an abstract while for other assignments an 

abstract can be omitted.  An abstract "is a brief, comprehensive summary of the contents of the 

article; it allows readers to survey the contents of an article quickly" (APA, 2010, p. 12).  A well-

written abstract can be the single most important paragraph in the article. If an abstract is a 

component of your manuscript be sure it is accurate, self-contained, concise, nonevaluative, 

coherent and readable.  The abstract should follow on the next page after the title page. Type the 

word Abstract in bold, uppercase and lowercase letters, centered, and at the top of the page.  

Place the page number 2 in the upper right-hand corner of the page. Write the abstract in a single 

paragraph using a block format (i.e., without paragraph indentation). 

 The Text 

 You begin the text of your manuscript on a new page. You type the title of the paper at the 

top of the page and center it.  Identify the first text page with the manuscript page header and the 

page number 3 in the upper right-hand corner of the page. You then double-space and begin 

typing the text.  
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 A quick note on the topic of plagiarism before you read the sections concerning the text 

mechanics. Plagiarism is when you claim the “words and ideas of another” as your own and not 

give credit to the original writer or author where the credit is due (APA, 2010, p. 15). That is, 

you “do not present the work of another as if it were [your] own work” (p. 16). So be sure when 

you paraphrase, quote an author directly, or describe an idea “that influenced your work, you 

must credit the source” (APA, 2010, p. 170). Plagiarism is a serious offense as well as an ethical 

issue.      

Spacing 

 When writing your paper you should double-space between all lines of the manuscript.  The 

APA (2010) manual suggests that you should "Double-space after every line in the title, 

headings, footnotes, quotations, references, and figure captions" (p. 229).   

Margins 

 APA style requires uniform margins of 1 inch at the top, bottom, right, and left of every 

page. In terms of line length, each typed line is a maximum of 6 ½ inches 916.51 cm).  Do not 

justify lines; that is, do not adjust spacing between words to make all lines the same length.  The 

right margin then will be uneven, or ragged.    

Page Numbers 

 Manuscript pages should be numbered consecutively, beginning with the title page. Number 

all pages. If you use a running head, have it along with a page number on each manuscript page. 

Type page numbers in the upper right-hand corner using Arabic numerals.   

Paragraphs and Indentation 

 You need to "Indent the first line of every paragraph and the first line of every footnote. For 
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consistency, use the tab key, which should be set at five to seven spaces or ½ in." (APA, 2010, p. 

229).  Type the remaining lines of the manuscript to a uniform left-hand margin.  There are some 

exceptions to these requirements such as the abstract, block quotations, titles and headings, and 

table titles and notes and figure captions.   

Quotations 

 If you quote from another author's published work, you must give that author(s) credit by 

providing a word-for-word quotation.  A short quotation of fewer than 40 words should be 

incorporated into text with the quotation enclosed with double quotation marks. When quoting, 

be sure to provide the author, year, and specific page citation. According to the American 

Psychological Association (2010) manual: 

If the quotation comprises 40 or more words, display it in a free-standing block of text and 

omit the quotation marks. Start such a block quotation on a new line, and indent the block 

about a half inch from the left margin (in the same position as a new paragraph). (p. 171) 

As indicated above, quotation marks are not used to enclose the quotation for those of 40 or more 

words. Be sure to double space the entire quotation.   

Numbers 

 The general rule when using numbers in your text is that you should “use numerals to 

express numbers 10 and above and words to express numbers below 10” (APA, 2010, p. 111). 

You should refer to pages 111-114 in the APA manual for exceptions to this rule.  

 

Paraphrasing Material 

 “When paraphrasing or referring to an idea contained in another work, you are encouraged 
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to provide a page or paragraph number, especially when it would help an interested reader locate 

the relevant page in a long or complex text” (APA, 2010, p. 171). 

Headings 

 Headings indicate the organization of a manuscript and establish the importance of each 

topic. The APA (2010) manual suggests that there are one to five levels of headings. Examples 

of the five levels of headings are provided below: 

 Centered, Boldface, Uppercase and Lowercase Heading (level 1) 

Flush Left, Boldface, Uppercase and Lowercase Heading (level 2) 

         Indented, boldface, lowercase paragraph heading ending with a period. (level 3)  

 Indented, boldface, italicized, lowercase paragraph heading ending with a period.  

 (level 4)  

 Indented, italicized, lowercase paragraph heading ending with a period.  (level 5) 

For  level headings 3, 4, and 5, you leave two spaces after the period and begin typing your text. 

 Please note that for the majority of manuscripts you will write, two levels of headings meet 

the requirements. In most cases you will use level 1 and level 2 headings. Refer to the APA 

(2010) manual pages 62-63, section 3.03 on selecting the levels of headings. 

Reference Citations in Text 

 APA style (6th edition) uses the author-date method of citation; that is, the surname of the 

author and the year of publication are inserted in the text at the appropriate point.  For example, 

Jones (2010) found that incivility occurs quite often in the college classroom. Another example 

would be having the citation at the end of the sentence. For example: In a recent study, it was 

discovered that classroom incivility is an ongoing issue (Jones, 2010). 
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 When a work has two authors, always cite both names every time the reference occurs in the 

text.  If a work has more than three, four, or five authors:  

cite all authors, the first time the reference occurs; in subsequent citations, include only the 

surname of the first author followed by et al. (not italicized and with a  

period al ) and the year if it is the first citation of the reference within a paragraph. 

  (APA, 2010, p. 175) 

Example: 

Galbraith, Sisco, and Jones (2010) found… [use as first citation in text] 

Galbraith et al. (2010) found… [use as subsequent first citation per paragraph thereafter]  

 When a work has six or more authors, cite only the surname of the first author followed by 

et al. and the year for the first and subsequent citations. In the reference list, however, provide 

the initials and surnames of each author.   

 In the running text, join the names in a multiple-author by the word and. In parenthetical 

material, in tables, and in the reference list, join the names by an ampersand (&) symbol: 

 as Smith and Jones (2010) demonstrated 

 as has been demonstrated (Smith & Jones, 2010) 

You should refer to the Citing References in Text section in the APA manual for specific 

questions concerning reference citations in text (see pages 174-183).   

 The Reference List 

 Manuscripts require a complete reference list of all citations noted in the text. Do not 

include references not cited. The reference list should begin on a new page, appear in 

alphabetical order at the end of your manuscript and have the word References centered at top of 
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the page.  

 According to the APA manual (2010), “APA requires that the reference list be double-

spaced and the entries have a hanging indent” (p. 180). Also remember that “a reference list 

includes only references that document the article and provide recoverable date, do not include in 

the list personal communications, such as letters, memoranda, and informal electronic 

communications. Instead, cite personal communications only in text (section 6.20 for format” (p. 

180).   

 Citations  listed in the References section should be arranged in alphabetical order by the 

surname of the first author followed by initials of the author’s given name. If you have an author 

or multiple-authors of several entries, then arrange by year of publication, the earliest first. For 

example: 

Galbraith, M. W., & Jones, M. S. (2008) 

Galbraith, M. W., & Jones, M. S. (2010) 

For more detailed information concerning the Reference List see pages 180-183.   

 Since the last APA edition, there have been changes in regard to electronic sources and 

locator information. According to APA (2010), “Electronic journal publishing has gone from 

being the exception to the rule. Publishing in the online environment has greatly increased the 

efficiency of publication processes and has contributed to a more vibrant and timely sharing of 

research results” (p. 187).  It is recommended that you include the same elements, in the same 

order, as you would a reference to a fixed-media source and add as much electronic retrieval 

information as needed for others to locate the sources you cited. Please review section 6.31 

concerning electronic sources and locator information, including uniform resource locators 
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(URLs) and digital object identifiers (DOIs).  The URL is used to map digital information on the 

Internet. For example, http://www.apa.org/monitor/oct00/workplace.html is a URL. In this 

example, the http: is the Protocol, www.apa.org is the Host Name, monitor/oct00 is the Path to 

document, and workplace.html is the File name of specific document. In terms of the DOI 

System, it provides a means of persistent identification for managing information on digital 

networks (see http://www.doi.org/)” (p. 188).  The DOI is a unique alphanumeric string assigned 

by a registration agency to identify content and provide a persistent link to its location on the 

Internet.    

 Please review pages 198-224 of the APA manual for a complete list of examples.  

Below are some examples of APA style references for the 6th edition. Not all possible 

combinations of reference examples are listed below.  

PERIODICALS (See pages 198-202 for examples) 

Journal Article with DOI  (one author) 

Kasworm, C. E. (2010). Adult learners in a research university: Negotiating undergraduate  

student identity. Adult Education Quarterly: A Journal of Research and Theory, 60, 143-

160. doi: 10.1177/0741713609336110  

NOTE: Give the volume number of journals, magazines, and newsletters. Do not use "Vol." 

before the number. If, and only if, each issue of a journal begins on page 1, give the issue 

number in parentheses immediately after the volume number (see the following example below).  

Journal Article without DOI  (two authors) 

Galbraith, M.W., & Jones, M. S.  (2008). Self-awareness and the Teacher of Adults.  

Perspectives: The New York Journal of Adult Learning, 6(2), 4-14. 
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NOTE:  If there is no DOI assigned and the reference was retrieved online, give the URL of  the  

journal home page  and do not include retrieval date. See the next example below. 

Sillick, T. J., & Schutte, N. S.  (2006). Emotional intelligence and self-esteem mediate between  

perceived early parental love and adult happiness. E-Journal of Applied Psychology, 2(2), 

38-48. Retrieved from http://ojs.lib.swin.edu.au/index.php/ejap 

Journal Article with DOI (three or more authors) 

Silver, M., Lochmiller, C. R., Copland, M. A., & Tripps, A. (2010). Supporting new school 

leaders from a university-based leadership coaching program for new administrators. 

Mentoring & Tutoring: Partnership in Learning, 17, 215-232. doi: 

10.1080/13611260903050148 

Magazine Article 

Chamberlin, J., Novotney, A., Packard, E., & Price, M. (2008, May). Enhancing worker well- 

being: Occupational health psychologists convene to share their research on work, stress, 

and health. Monitor of Psychology, 39(5), 26-29.  

NOTE:  If you retrieved an online magazine you write it the same but you omit the page 

numbers and put the URL information. 

Newsletter Article 

Brown, L. S. (1993, Spring). Antidomination training as a central component of diversity in 

clinical psychology education. The Clinical Psychologist, 46, 83-87. Retrieved from 

http://www.apa.org/monitor/ 

Daily Newspaper Article (no author) 

New drug appears to sharply cut risk of death from heart failure. (1993, July 15). The 
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Washington Post, p. A12.  

BOOKS, REFERENCE BOOKS, AND BOOK CHAPTERS (See pages 202-205 for examples) 

Book 

Galbraith, M. W. (2008). College teaching: Developing perspective through dialogue. Malabar, 

FL: Krieger. 

For an entire book, you can use the following reference formats as well: 

Author, A. A. (2008). Title of work. Retrieved from http://www.xxxxxxx 

Author, A. A. (2008). Title of work. doi: xxxxxx 

Edited Book 

Galbraith, M. W.  (Ed.). (2004). Adult learning methods: A guide for effective instruction (3rd. 

ed.). Malabar, FL: Krieger. 

Chapter in an Edited Book 

Galbraith, M. (2004).  The teacher of adults.  In M. W. Galbraith (Ed.), Adult learning methods A 

guide for effective instruction (3rd. ed. pp. 3-21). Malabar, FL: Krieger. 

For a chapter in an edited book, you can use the following formats as well: 

Author, A. A. (2008).  Title of chapter entry. In A. Smith (Ed.), Title of the book (pp. #s). 

 Retrieved from http://www.xxxxx 

Author, A. A. (2008).  Title of chapter entry. In A. Smith (Ed.), Title of the book (pp. #s). 

 Location: Publisher. doi: xxxxxx 

 

SOME ADDITIONAL TYPES OF REFERENCES (See pages 205-216 for examples) 

Monograph 
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Galbraith, M., & Gilley, J. (1986).  Professional certification: Implications for adult education 

and HRD (Information series No. 307).  Columbus, OH: ERIC Clearinghouse on Adult, 

Career, and Vocational Education. 

Conference Proceedings 

Girondi, R.A., & Galbraith, M. W. (1992). Assessment of instructional styles in postsecondary 

proprietary schools. In A. Blunt (Ed.), Proceedings of the 33rd Annual Adult Education 

Research Conference (pp. 88-93). Saskatoon: University of Saskatchewan. 

Author as Publisher 

American Psychological Association. (2010). Publication manual of the American 

 Psychological Association (6th ed.). Washington, DC: Author. 

Unpublished Paper Presented at a Meeting 

Galbraith, M. W., & Sisco, B. R. (1994). Improving teaching and learning practice: 

Understanding thinking styles.  Paper presented at the annual meeting of the American 

Association for Adult and Continuing Education, Nashville, TN. 

Unpublished Doctoral Dissertation or Master’s Thesis 

Siler, C. R. (1985). A content analysis of selected United States history textbooks concerning  

World War II. (Unpublished doctoral dissertation or master’s thesis). Ball State University, 

Muncie, IN. 

Electronic Media 

The World Wide Web has created a wealth of opportunity to find electronic references and 

resources. These include, but not limited to, electronic versions of books, corporate and 

government reports, journal articles, videos, archival resources, and so forth. Because there is a 
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variety of information that can be secured from the WWW, it is suggested that you review pages 

208-215 in the APA manual (2010) to review how electronic media is referenced.   
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Being Sensitive in Your Writing 

 Good writing is committed to the fair treatment of individuals and groups. It is important to 

avoid perpetuating demeaning attitudes and biased assumptions about people in your writing. 

The APA (2010) manual suggests that "Constructions that might imply bias against persons on 

the basis of gender, sexual orientation, racial or ethnic group, disability, or age are unacceptable" 

(p. 71).  

Gender 

 The APA (2010) manual indicates that “Gender is cultural and is the term to use when 

referring to men and women as social groups” (p. 71). Sex is “biological; uses it when the 

biological distinction is predominant” (p. 71). You can avoid ambiguity in sex identity or sex 

role by choosing nouns, pronouns, and adjectives that specifically describe participants. The 

APA (2010) manual states, "Sexist bias can occur when pronouns are used carelessly, as when 

the masculine pronoun he is used to refer to both sexes, or when the masculine or feminine 

pronoun is used exclusively to define roles by sex (e.g., “the nurse...she” (p. 73). 

Sexual Orientation 

 Sexual orientation refers to an enduring pattern of attraction, behavior, emotion, identity, 

and social contacts. Sexual orientation should be used rather than sexual preference. According 

to the APA (2010) manual: 

The terms lesbians, gay men, bisexual men and bisexual women are preferable to 

homosexual when one is referring to people who identify this way. Lesbian, gay and 

bisexual refer primarily to identities and to the culture and communities that have developed 

among people who share those identities. (p. 74) 
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Racial and Ethnic Identity 

 The APA (2010) manual states that, "Preferences for terms referring to racial and ethnic 

groups change often. One reason for this is simply personal preference... Another reason is that 

over time, designations can become dated and sometimes negative" (p. 75).  In your writing, it is 

acceptable to use the terms Black and African American. However, Negro and Afro-American 

have become dated terms of identity. In addition, terms such as Hispanic, Latino, Chicano, 

American Indian and Native American, Asian or Asian American are acceptable designations for 

some ethnic groups.    

Disabilities 

 The guiding principle for "nonhandicapping language is to maintain the integrity (worth) of 

all individuals as human beings” (p. 76). “Avoid language that objectifies a person by her or his 

condition (e.g., autistic, neurotic,); that uses pictorial metaphors (e.g.,  wheelchair bound or 

confined to a wheelchair), that uses excessive and negative labels (e.g., AIDS victim, brain 

damaged) , or that can be regarded as a slur (e.g., cripple, invalid) (APA, 2010, p. 76). Use 

disability to refer to an attribute of a person and a handicap to refer to the source of limitations, 

which may include attitudinal, legal, and architectural barriers as well as the disability itself  

Age 

 Several terms, as they relate to age, are preferred in writing using APA style (6th ed.). For 

example,  

  girl and boy are correct terms for referring to individuals under the age of 12 years.  

  Young man and young woman and female adolescent and male adolescent may be used 

  for individuals aged 13 to 17 years. For persons 18 years and older, use women and men.  
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 (p. 76)   

 The terms elderly and senior are not acceptable as nouns; some may consider their use as 

adjectives pejorative. The term older person is preferred.  

Final Comments 

 The Publication Manual of the American Psychological Association (2010) is a valuable 

resource and aid in your writing process. By reviewing the manual carefully, you will gain 

additional insights into the information presented above as well as in-depth information on topics 

such as expressing your ideas, grammar, reducing bias in language, punctuation, spelling, 

capitalization, abbreviations, headings and series, quotations, numbers, tables and figures, 

manuscript preparation for publication, electronic media, and much more. Because APA style is 

the most widely preferred style by the majority of professional journals, it is imperative that you 

gain mastery of this style as you work through your writing assignments as a graduate student, 

and then on into professional roles that require publication production.  Good luck! 
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APPENDIX E:  USING MS WORD 

 
DISSERTATION FORMATTING TIPS—USING MS WORD 
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Dissertation Formatting Tips - Using MS Word 

 
1. Online Resources  

MU Electronic Theses and Dissertations @ http://www.marshall.edu/etd/ 
 

2. Important Documents (save multiple electronic copies) 
 
3. MU Dissertation Template 
 
4. Formatting Tips 
Please note that specific formatting requirements vary from institution to institution. Your 
dissertation committee may have preferences that differ from the information provided. A 
lot depends on how closely APA is followed. 
 

 Page margins (Page Layout Ribbon> Margins) - at least 1" margins on all sides. 
 

 Font (Home Ribbon> Font) or (For existing test, select the text (Home Ribbon, 
Editing, Select, Select All) then change the font) - Times New Roman, 12 pt. is 
standard, Arial font (or other) may be used with committee approval. 
 

 Style Sheet Setup (Home Ribbon> Styles group (arrow) 
 

 The Styles window will open > Select Options> Select Styles to Show> Choose   
All Styles and click OK > 

 
 Find Heading 1 and Select the Arrow to the right> From the Menu choose Modify 

(Set font type and style and click Format> Font to add All Caps) Make sure the 
Automatic Update has a checkmark) 

 
 To apply the heading Select the text and click on the Heading Name in the 

Styles window. Style sheets allow you to setup common formatting that will be 
used repeatedly within your document. Using style sheets will also allow you to 
utilize built-in program features for automatically generating the table of contents 
for your document. Normal text (12 pt.) 

o Heading 1 (center, all caps, 12 pt., bold) - for major sections, like Table of 
Contents, Chapters, etc. 

o Heading 2 (center, title case, 12 pt., bold) - for chapter titles. 
o Heading 3 (center, italics, title case, 12 pt.) - for sections within a chapter. 
o Heading 4 (left, italics, title case, 12 pt.) - for subtopics within chapter 

sections 
o Blockquotes (increased 0.5" left margin) 

 
 Section breaks (Page Layout Ribbon> Page Setup groups> Breaks>Section 

Break Types> Next Page) - insert section breaks to start a new page between each 
major section of the dissertation. 
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*For the Dissertation 
Section Break between Pages 1 - 2 
Regular Page Break between pages 2 - 3 
Section Break between Front Matter and Chapter 1 
 

 Title page - considered front matter, refer to institutional requirements to review the 
content that should appear on your title page. The title page is counted as the first 
page, Roman numeral i (lower case) of your dissertation, however, the actual number 
(i) should not appear on the page. 

 
 Abstract - considered front matter, the abstract is typically counted as the second 

page, Roman numeral ii (lower case) of your dissertation, however, the actual number 
(ii) should not appear. The maximum suggested length is 350 words for a dissertation 
abstract.  

 
 Dedication (optional) - considered front matter, if included, the dedication page is 

numbered with a lower case Roman numeral. 
 

 Acknowledgments - considered front matter, the acknowledgments page is numbered 
with a lower case Roman numeral. 

 
 Table of Contents (References Ribbon> Table of Contents group>Table of Contents 

(explore Formats, Options, etc.)) - considered front matter, the Table of Contents 
should list all front matter (except the title page and abstract) the body, including 
headings 1-4, and the back matter. As you make changes to your document, you may 
update the table of contents ... References Ribbon> Table of Content group>Update 
Table. 

 
 A section (page) for each of the following should be included, as appropriate: List of 

Tables; List of Figures; List of Symbols, Abbreviations, or Nomenclature; and 
List of Multimedia Objects or Files, considered front matter numbered with a lower 
case Roman numeral. 

o Setup a Word generated List of Tables or Figures: References Ribbon 
Captions Group> Insert Table of Figures> Choose Tables or Figures>OK.  If 
new tables or figures are added to the document, right-click>Update Table ... 
to update the list and page numbers. 

o To create a Figure/Chart in the body of your document: Insert Ribbon 
Illustrations group> Chart, enter the desired data, close (X) the window when 
finished, click off the chart to deselect its contents. 

o To create a Table in the body of your document: Insert Ribbon>Tables group> 
Insert Table> Choose Options> OK. 

o To add a Caption: select the chart or figure that needs a caption by 
highlighting or clicking. Go to Select Chart> Insert Ribbon> Captions group> 
Insert Caption. 
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o To add a Caption: select the table that needs a caption by highlighting or 
clicking. Go to Insert Ribbon> Captions group> Insert Caption>OK. 
 

 Body - typically includes five chapters, including: Introduction, Review of Literature, 
Methods, Results, and Summary and Conclusion. Titles may vary according to the 
requirements specified by your committee. Pages in the body should be numbered 
using Arabic numerals, beginning with 1. 

 
 Bibliography - considered back matter, each source should be typed using a hanging 

indent (Page Layout Ribbon> Paragraph group>Options(small arrow facing 
downwards) > Indents and Spacing Ribbon>Special list under Indentation click 
Hanging) 
 

 Appendix - if included, this section is considered back matter and is numbered with 
Arabic numerals continued from the body. 

 
 Curriculum Vitae - this section is considered back matter and is numbered with 

Arabic numerals continued from the appendix (or body, if an appendix is not 
included). 

 
 Page numbers 

o Should appear in the bottom center of the page footer. 
o Preliminaries (front matter) should be numbered using Roman numerals (i, ii, 

iii) 
o Title page counts as page i, the i should not appear on the actual page 
 
Part 1 (go to (Insert Ribbon> Header and Footer group> PageNumbers> Format 
Page Numbers> Change to iii format) 
Part 2 (Insert Ribbon> Header and Footer group> Page Numbers> Select Page 
Position and style) 
Part 3 Go to Page 1 and Select "Different First Page" to remove the page number 
from page 1. Do the same for page 2. 
Part 4 Go to the first page of Chapter 1 and select the number in the header. 
Change the formatting to 1,2,3 and change from continue to Start At: 1. 

o Abstract page counts as page ii, the ii should not appear on the actual page 
o All remaining front matter should be numbered using Roman Numerals) 
o Remaining pages (body and back matter) should be numbered 

consecutively using Arabic numerals (1, 2, 3...). 
 

Formatting Tips - Introduction to Using MS Word 2007 (* 2010 
version) 
 
1. Open/Save 

a. Open - Office Button > Open 
b. Save - Office Button> Save 
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c. Save for Online classes - Office Button> Save As > Word 97 -2003 
Document. 
 

2. Ribbons 
The Ribbon is the panel at the top portion of the document. It has seven tabs: 

a. Home: Clipboard, Fonts, Paragraph, Styles, and Editing. 
b. Insert: Pages, Tables, Illustrations, Links, Header & Footer, Text, and 
Symbols. 
c. Page Layout: Themes, Page Setup, Page Background, Paragraph, Arrange. 
d. References: Table of Contents, Footnote, Citation & Bibliography, Captions, 
Index, and Table of Authorities. 
e. Mailings: Create, Start Mail Merge, Write & Insert Fields, Preview Results, 
Finish. 
f. Review: Proofing, Comments, Tracking, Changes, Compare, Protect. 
g. View: Document Views, Show/Hide, Zoom, Window, Macros. 

 
3. Printing - There are 3 printing options available in Word 2007: 

a. Print (Microsoft Office button > Print> Print) 
b. Quick Print (Microsoft Office button > Print> Quick Print) 
c. Print Preview (Microsoft Office button > Print> Print Preview) 
 

4. Formatting Tips 
 Page margins (Page Layout Ribbon> Margins, Custom Margins) - at least 1"   

margins on all sides.  
 

 Page Numbering (Insert Ribbon> Page Number button> Bottom Center of 
Page,…) – Page numbers can be either at the top or the bottom of the page, 
aligned either left, center, or right. To add text before or after the number, just 
begin typing; the cursor is already flashing and ready for you to enter text.  

 
 Font Matter (Insert Ribbon> Page Number> Format Page Numbers> select 

“i, ii, iii” as the Number Format>OK>check box for different first page> 
scroll to the next page. (* 2010 version is the same except you check “start at 
box” and add the page number you want> then scroll to next page). 

 
 Font (Home Ribbon> Font) or (For existing text, select the text (Home Ribbon, 

Editing, Select, Select All) then change the font)-Times New Roman, 12 pt. is 
standard. Arial font (or other) may be used with committee approval. 

 
 Line spacing (Home Ribbon> Paragraph group> Line Spacing button) - Line 

spacing sets the amount of space between lines within a paragraph.  
 

 Indent Paragraphs (Page Layout ribbon> Paragraph group> Indent (Left or 
Right)) - Indentation allows you to indent your paragraph from the left and/or 
right margin. 
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5. Tables 
 Go to the Insert Tab> Table> Insert Table 

 
 Insert/Delete Column/Rows - Make sure your cursor is inside the table; this 

will open the Tables Tools Tab. Table Tools> Layout>Rows and Columns 
group> choose appropriate action. 

 
 Change Column Width - Move your mouse over the line to the right of the 

column until you have a two-headed arrow, click and drag your mouse to the 
appropriate column width. 

 
 Turn off Lines or Shade Cells - Table Tools> Design> Table Styles 
 

6. Citations - citations can be used to create and insert Citations & Bibliography 
information into your document. 

 Create a Citation - Prior to inserting a citation you must chose a style of citation. 
To do this, go to References Ribbon> Citations & Bibliography Group> Style 
to choose your style. To insert the actual citation go to the References Ribbon > 
Citations &. Bibliography Group> Insert Citation> Add a new Source and fill 
out the form of the appropriate source. 
 

 Insert Bibliography - Go to the end of your document. Go to References 
Ribbon> Citations &. Bibliography Group> Choose style. Once the 
Bibliography is inserted, highlight the section and apply the proper formatting. 

 
7. Mailing and Labels 
 
When it comes time to do your research, you can easily create labels for your mailings. 
The first stage is to create a spreadsheet in Excel and then you will use the mail merge 
feature of Word to format the labels. 
 

 Create a new blank document. Go to the Mailings Ribbon> Start Mail Merge in 
the Start Mail Merge Group> choose Labels> identify and select the correct label 
and click OK. > 

 
 In the Mailings Ribbon> click Select Recipients from the Start Mail Merge 

Group> Use Existing List> Navigate to the proper spreadsheet and select it and 
click Open. > In the sheet window select the Sheet name and click OK (the sheet 
name will be Sheet! (unless you have renamed it in Excel.) 

 
 In the Mailings Ribbon> Write and Insert Fields Group select Insert Merge 

Field> Insert the fields in the order you want them to appear on the labels making 
sure to insert proper formatting between the fields, such as spacing and hard 
returns. (First Name, Last Name, Address, City, etc.) > After inserting the fields 
click the Update Labels button in the Write & Insert Fields. 

 In the Mailings Ribbon> click Preview Results in the Preview Results Group. 
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 At this point if you need to make changes to the font or size, you can do so by 
selecting the document and making the changes. 

 
 Once everything is acceptable from the Mailings Ribbon> choose Finish & 

Merge in the Finish Group> Edit Individual Documents>Select All > Ok 
 
Tips 
 
Copy/Paste - To Copy you must first highlight the text or item to be copied then go to 
the Home Ribbon> Clipboard Group> Copy. Move to the place you want to insert the 
text and go to the Home Ribbon> Clipboard Group> Paste. You can also use the short cut 
keys ctrl+C for copy or 
ctrl+V for paste. 
 
Change Case - This command allows you to change the case of written text. Home 
Ribbon> Font Group> Change Case. 
 
Replace - This command allows you to search the document for specific items and 
replace them. Home Ribbon> Editing Group> Replace. 
 
Split - This allows you to temporary split a document so you can see two different parts 
at one time. View Ribbon> Window Group> Split> Click where you want the split to 
occur. 
 
Format Painter -Highlight the text that contains the format you want applied to other 
section, go to the Home Ribbon> Clipboard Group>Format Painter. Highlight the text 
you want the format applied. The new text should contain the format of the previous text. 
 
Using Word 2007 with WebCT - WebCT does not accept the “.docx" file format of 
Word 2007, therefore each time you have a file you want to submit to WebCT, you must 
change it to the correct format. To do so go to the Office Button> Save As> Word 97 - 
2003 Document. You may also change the default save option to Word 2003 by clicking 
Office Button> Word Options> Advanced> under Compatibility Options for change 
to All New Documents and under Layout this document as if created in choose Word 
2003. 
 
The Quick Access Toolbar 
 
To Customize the Quick Access Toolbar: 
1. Click the drop-down arrow next to the Customize Quick Access Toolbar button. 
2. From the resulting menu, select More Commands. 
3. From the Choose commands from drop-down menu, select a category.  
4. In the box on the left, select the command you wish to add and click the Add button. 
5. Click the OK button. 
6. Note: To remove a command from the toolbar, select the command you wish to 
remove from the box on the right and click the Remove button. 
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